The GoldBook for WineBase 7.1

About the GoldBook

How to start it

What to use it for

Main Edit Dialog

The GoldBook for WineBase contains the complete book, with every field
indexed. This allows you to search on any one aspect of the book, and ensures
that the search facilities are both comprehensive and are performed at the
highest speed available.

On a typical 486 computer, the GoldBook for WineBase will perform a
complete search, with all search fields containing a search criteria in less than
one second.

The results of a search will only list wines that match the search criteria.

Therefore if you do a search for Bin 707's that will be at their best in 2002, you
wouldn't expect to have all vintages from 1976 to 1992 listed. The only two
wines that match the search criteria are the 1988 and 1989 vintages.

The GoldBook for WineBase will only show these two, not a list of all Bin
707 vintages in the book, with the two you want lurking somewhere in the list.

The GoldBook for WineBase can be selected from the View Menu, or by
clicking the button with the small Gold Book on it.

A typical use for this program is to identify (quickly) wines of a particular
variety, of a certain quality, that will be suitable to drink in a particular year,
and cost an amount that you can afford.

ie Find all the Chardonnay wines that will be at their best in 1996, having a
Star Ranking of 5, a Vintage Rating of 7 and cost between $20 and $29 (there
are five of them).

The GoldBook is also linked to the Main Edit Dialog.
You only need to enter a Vintage and a Winery name (or part of a name)

Clicking on the Look up GoldBook button will list all wines that match the
Vintage and Winery name.

Select the required wine from the list by clicking on it. The values for
GoodFrom, BestAt, GoodTo and Value will be displayed underneath the list of
wines.

To accept these values click on Yes, and they will be placed in the respective
Main Edit Dialog edit fields. The Winery Name, Label and Variety will also be
exported to the Main Edit Dialog and the Star Ranking and Vintage Rating will
be placed in the 'User 2' field.

You can accept a wine quickly by double clicking on it in the list.

The search will only find 20 different wines, which is fine if you enter the full
winery name or enough letters to identify it. ie Pen will find Penfolds. If you
enter only a single letter as a winery name ie C (or c), this will exceed the limit
of 20 and you will be informed that the search criteria is too broad.

You can use the Up / Down arrow keys on the keyboard to move up and down
the list, and ENTER to accept the highlighted wine.



The GoldBook for WineBase 7.2

Searching the GoldBook

Start Search

Clearing Fields

Scrolling Results

Other Information

GoodTo Date

There are eight fields in the book, these are ...

Vintage The year the wine was made.

Winery The company that made the wine.

Label A name the winery may put on the bottle.
Variety The variety(s) of grape used.

Star Ranking An overall ranking of the wine.

Vintage Rating The makers rating for each vintage.

Best Drinking Year An estimate of the best year to drink.
Current Value What the wine is currently worth.

The GoldBook for WineBase lets you search on all these fields. You can
search on only one or all eight at the same time. The Vintage, Winery, Label,
Variety and the Best Drinking Year have drop down lists that you can select
by clicking the down arrow to the right of the field, or enter information by
clicking in the field. This is not case sensitive and partial words can be entered

ie Entering 'P' or 'p' in the Winery Edit Field will find all wines from wineries
starting with 'P'. If you entered 'Pen’, the search would find all wines from
Penfolds.

Once a drop down list is opened, you can move up and down with the cursor
keys, the scroll arrows or entering the 1st letter of a word in the list.

The Vintage Edit Field requires a four digit date .. eg. 1990

The Best Drinking Year (BestAt) requires either a date, eg. 1996 or Now or
Prior.

The Star Ranking, Vintage Rating and Value fields have drop down lists of
available choices. Click in any of these white Edit Fields to display the list and
then click on the required one.

You start the Search by clicking the Start Search button. The results are listed
in the Cyan windows beneath the Green Edit Fields.

To clear all the Search Edit Fields use the Clear Search Fields option from
the Menu.

The list of results may be up to 3,500 lines long, and you can scroll up and
down the list by using the KEYBOARD cursor control keys.

These are the UP, DOWN arrow keys, the PAGE UP, PAGE DOWN keys
and the HOME and END keys.

The Winery field is linked to the keyboard, so you can use the first letter of the
winery name to move up and down the list. ie Hitting 'z' will take you to the
first winery starting with 'z' or '2".

In the bottom left hand corner of the screen the details of the currently
highlighted wine are listed in a format that is easy to read, and next to this (on
the right) is a maturity graph, derived from the Vintage and BestAt data.

Is derived from the Vintage and BestAt date and assumes that the BestAt date
is in the mid point of the Maturity curve.



Cellar Mapping

Overview

Definitions

Defining the Racks

Recommendations

8.1

WBIfW includes the ability to assign individual bottles of wine to a location
in a Rack. The system allows you to easily display the position of bottles in
your cellar.

The basis of the system is a Bin, which holds 12 bottles, ie. a case of wine.
A Bin is 4 bottles wide and 3 high. There are 512 Bins, which are numbered
from 1 to 512.

These Bins are arranged into Racks, which can be up to 8 Bins high and 8
Bins wide, or a small as 2 Bins high or wide. You can have up to 16 Racks,
each of which you can name.

Whilst not recommended, you can have the one wine (different bottles of)
in up to 4 different Bins, each of which could be in a different Rack.

The File menu has a Cellar Rack Layout option, which leads to a Dialog
Box with all 16 Racks listed and provision for setting the Height, Width,
Rack Name and the number of the first Bin in the Rack.

The number of the first Bin is important. The Bins in each Rack are
numbered starting with the first Bin number, from the top left corner, across

the Rack and down to the lower right corner.

So a 6 X 6 Rack starting at Bin 1, would be numbered like this.

1 2 3 4 5 6

7 8 9 10 11 12
13 ... ... 30
31 32 33 34 35 36

The next rack would start at Bin number 37.

In order to make working out the first Bin number for each Rack, the Dialog
has a 'Auto Bin Number' button. This will assign all the first Bin numbers
based on the Width and Height of the Racks.

As some people have a storage area in the house, which is easily accessible,
another main rack system in a 'cellar’, and maybe a bulk storage area, it is
recommended that Rack 1 is the one in the house and starts at Bin 1. It
could be called 'Dinning Room' or 'Drinking Stock' etc.

As this Rack will only hold 3 - 4 Bins, this will make it easier to remember
the Bin numbers (ie 1,2,3 or 4), when you wish to shift bottles from the
'cellar' to the house.

If you have a bulk storage area (ie. whole cases), you might wish to allocate
it to Rack 16, called 'Bulk Storage' and start it at 200 or more (depending on
how many whole cases you have). This will allow for expansion of you
main cellar area.

It doesn't really matter, as the system will let you have the racks in any
order, but this system will keep the menus neat, and give you a better idea
of the true cellar layout.

If you do not wish to use the Cellar Mapping feature, do not map any
bottles, and you will then never be reminded of its existence.



Cellar Mapping (cont.) 8.2

Allocating bottles to Bins

Viewing a Wines location

Viewing an entire Rack

The Main Edit Dialog has a "Map' button next to the Cellar Location Field. The
Dialog Box that appears has 4 groups of Edit fields and Check Boxes.

For a new wine that has not been mapped, all the Edit boxes will be empty and
all the Check boxes will be blank, with a Minus sign next to them. This
signifies that they are empty.

If the wine has been mapped, then one or more of the Edit fields will have a
Bin number and the some of the Check Boxes will be 'ticked'. There are three
possible symbols that will appear next to a Check Box.

- Empty
0 Has another wine in it
+ Has this wine in it.

To see the contents of a Bin, enter the Bin number into the Edit field, and click
the '"Map' button which is next to it.

You can only place a wine in a Bin location that is empty. You cannot place a
wine in a location which has a "o' next to it. Yes the Tick will toggle on or off
if you click on the Check Box, but the changes will not be saved.

Clicking on a Check Box, which is ticked and has a '+' next to it. removes this
wine from that location, which answers your next question of "How do I
remove a bottle?".

If you Map a wine, then using the 'Quick Drink' function, or altering the totals
for a wine, will cause this Dialog Box to appear, so you can match up the totals
in Data File and the Cellar Map, by removing or adding bottles to the Rack.

The Index listing has a 'HotSpot', which is the Cellar Location field. Left
clicking on this will bring up a diagram of each Bin that the particular wine is
stored in.

The View menu has a option called Cellar Rack Map, this leads to further
choices of Rack Structure, List to Index and Clean Up Racks.

Rack Structure leads to a Sub Menu that has each of the 16 Racks listed,
numbered 1 to 16. Racks that have been defined will have their names next to
the number. Select the required rack by clicking on it.

The rack will be displayed, and the contents of the first Bin will be displayed
on the right of the screen. This includes a picture of the Bin, with bottles
numbered A1 ... B3, and a list of the wines matching those locations.

The bottles are colour coded by Maturity. Left clicking on any of the Bins in
the Rack, will list its contents.

List to Index, has a similiar Sub Menu and will list the contents of a rack to a
standard Index list, with the Rack Bin number and location listed.

Clean up Racks will remove any bottles from the Racks that should not be
there. This fixes a problem in earlier versions, where it was possible to have
bottles shown in the Racks that did not have a wine to match in the data file.



Health Report

Age Groups

The Health Report

9.1

WBIfW classifies wines in one of five age groups. These age groups
are represented by colours, which are consistent in all Listings,
Graphs and Tables.

The five groups are ...

¢ Non Vintage Blue Fortified or wines with no definite
o shelf life.

*  Young Green Too young to drink.

¢ Improving Cyan Can drink but not at their best yet.
e  Mature Yellow In the stable period, at their best.
¢ Danger Red Past their useful life expectancy.

The Health Report gives useful information and totals. Two bar
graphs show distribution by Maturity. The left graph is by total
different wines in each group, and the right is by total bottles in each

group.
The right graph is the one you have to worry about.

Wines with no bottles, but still existing in the database will not show
up in this report or any other Graph or Table. They will be not be
listed in any Index Listings unless you search for 'Lost Souls'.

This means that if you drink the last bottle of a particular wine, all
details still remain. So if you then buy more bottles, all you have to
do is adjust the bottle count. If you are not going to buy more of that
wine, you can Edit the file and replace it with another wine, or delete
it

You can print this Report by clicking on the "Printer' button on the
Graph WineBar.



Graphs 10.1

Making figures Fun WBfW includes seven graphs to help you sort out your cellar.

These graphs are ...

¢ Cellar Value and Stock plotted on a monthly basis.

¢ Vintage Distribution all vintages found.

¢ 'Best At' for all Wines '‘Best At' in future.

e 'Best At' by Grape Variety '‘Best At' in future by Variety.
* Ageing Curve entire cellar Ageing.

* Winery Distribution all Wineries found.

¢ Region Distribution all Regions found.

® Variety Distribution all Varieties found.

They take the form of bar graphs, with two bars per Month, Variety and
Vintage. The Blue bar represents different wines, except in the Cellar
Value and Stock graph were it represents Dollars or whatever currency
you use. The Cyan bar is total bottles in all graphs.

You can display Wines, Bottles + Wines or Bottles only, by using the
WineBar Buttons.

The Cellar Value and Stock, and the Distribution graphs are auto sizing
and will adjust the width of the bars according to the number of months

or varieties found.

The Vintage Distribution graph shows from the current year back thirty
years.

The Ageing Curve graph shows total bottles against health, from now to
twenty years time.

You can print all these Graphs except for Cellar Value and Stock.

ps



The BestAt Graphs

Planning your Cellar

BestAt vs Variety

A Table to work with this

10.2

The Best At Distribution graph has proven to be the most popular of the
WB{W Graphs.

This Graph plots each wine in the cellar against its nominal BestAt date,
and quickly shows how many wines you will have at their 'Best' for each
year into the future (up to 20 years at least).

As such it is a very good tool for planning your cellar, as any holes, or
peaks can be seen and remedied before the actual date arrives.

ie Nothing to drink in 2000, 2001, 2003 but in 2004 we have 435 bottles
that are at 'their best'. Even taking into account the spread of years that a
'‘BestAt' date actually covers, this is not a good situation.

Buying wines on special, or just something that catches your eye may
seem a good idea at the time, but if they all mature at the same time,
you are heading for trouble.

With WBfW and the GoldBook for WBfW you can select the years you
need to fill up, and ensure that you have a consistent quantity of wines
that will be drinkable each year.

Wines that should have been drunk by now are shown on the left hand
side of the Graph in red.

I have always considered the original BestAt Graph to be a bit
inaccurate. After all it lists all the wines in the cellar, and whilst some of
those peaks may be made up of long living reds and therefore can be
spread about a bit, they might be short living whites.

How do you tell. Simple. There is a new BestAt graph (actually several
of them).

Next to the BestAt button is a new button which is basically the same
except it has a bunch of grapes on it.

When you click this, a Dialog box listing every Grape Variety in your
cellar will appear.

Selecting anyone of them will generate a BestAt graph containing only
those varieties.

This makes it very easy to see what all the Shiraz's are doing, or the
Rieslings or whatever.

There is also a new Table, which plots Variety vs BestAt vs Stock,
which gives you a good overall picture of the cellar.

Used in conjunction with the BestAt vs Variety Graph it should make
planning your cellar just that little bit easier.



Tables

Displaying Tables

'"Time Line'

11.1

WBfW includes five tables to help maintain your cellar.

Variety vs Vintage vs Bottles.
Variety vs BestAt vs Bottles.
'Label' vs Vintage vs Bottles.
'Label' vs Vintage vs Maturity.
'"TimeLine' of all Wines in Cellar.

The table's consist of every unique Variety or Label plotted against
time, showing total bottles or maturity. They cover from the current
year back thirty years. Non Vintage wines have a separate column on
the left side, marked Nv. The screen is scrollable so you can browse
up and down the table's. The maximum number of rows is 1200.

Label refers to the complete Label of the wine ie. Maker, Brand
Name (Label, Bin etc) and Variety.

These are listed alphabetically.

The most useful tables are the 'Label' vs Vintage vs Maturity,
particularly if you collect different vintages of the same wine, and
the Variety vs BestAt vs Bottles as it helps you plan your cellar.

The 'Label’ vs Vintage vs Maturity table is shown below.

The 'TimeLine' table is of a different format and lists all wines sorted
by Vintage down the table, and plots each wines ageing
characteristics across the page, starting with green and ending in red.

The TimeLine is now linked to the Tasting Schedule and Left
Clicking on any of the TimeLine bars will produce the Tasting
Schedule Dialog Box.

Using the TimeLine data you can easily fill in the Tasting Schedule
entries for each wine.



Maps

How to Display Maps

Australian Reference Map

12.1

On the Graph 'WineBar' is a Map of the World. Clicking on this
leads to this Dialog Box.

Any files with the extension of .BMP, that are in the WBfW
directory will be listed. Click on any one of them to select and Click
on OK to display it, or double click on the map name to display it.

Some of the Australian regional maps are require a scrollable screen
to display them. Use the "Map of Australia" to access them.

The 'Map of Australia’' button on the Graph 'WineBar', displays the
Australian map. This map has 'Hot Spots' on it, that are centred on
the green wine growing regions.

When the mouse pointer is over a 'Hot Spot' it will change to a
'Hand' or a 'Hand in a Square'.

Clicking the left mouse button when the pointer is a 'Hand', results in
this Dialog Box being presented. Clicking on any of the listed
Wineries will list its details. 'List all Wineries', lists all Australian
Wineries (that I have information on).

The 'Hand in a Square' pointer, when right clicked, will produce a
map of that region.



Other Matters

Written using

VGA Modes

Feedback

Notes

13.1

WBfW was written using Borland Pascal from Borland
International Inc. Using ObjectWindows and OOP techniques.

This user's guide was written using Word for Windows from
Microsoft Corp.

I recommend both these products.

This program was designed to run on standard 640 X 480 VGA.
Versions 1.5 on support 800 X 600,1024 X 768 and 1280 X 1024
modes. The program starts up as a window scaled to fit the menu in,
centred in the screen. The main window can be resized or run
maximised. All screens will scale all output to fit across the screen.
The program matches screen colours in each mode to the standard 16
colours available in 16 colour VGA mode. It (like most other
Windows programs) looks better in 256 colour or 32K colour modes.

A shareware program grows as a result of registrations coming in and
feedback from user's. If you have any comments or suggestions about
features you think would make the program better, feel free to write
to me and let me know.

One area that I have been a bit disappointed with is the Winery Files.
WB{W has been in the public eye now for eight months, and still we
have only three Winery Files.

If you are in someway connected with a winery or have a favourite
one, put a file together (or send me the printed information), so we
can include it in WBfW.

Just about everybody that uses WBfW keeps asking me when we are
going to get more Winery Files, but as yet very few people are doing

anything about getting the required information.

Your notes here ...



